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Introduction

The following guide is intended to guide the user in how to install, uninstall,

load and unload Connect on Linux.
Connect for Linux includes the Guest and Host.

The Guest can connect to a remote Host through the following communication
protocols:

e |mpero Portal

e Internet (TCP)

e LAN (TCP)

e WebConnect and WebConnect3

The Host uses the following communication protocols to connect to the

Guest:

e |mpero Portal

e Internet (TCP)

e LAN (TCP)

e UDP

e HTTP

e WebConnect and WebConnect3

Install

Before you install the Host and Guest, make sure that your computer meets

the following minimum technical requirements:

Supported platforms: 32 & 64-bit

e Red Hat Enterprise Linux 7
e Ubuntu 16.04, 18.04, 20.04
e SUSE 12
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NOTE: Supported X Window System is X.org

Memory:
e For the Guest a minimum of 1 GB (2 GB recommended)
e For the Host a minimum of 512 MB (1 GB recommended)
Disk space:
e For the Guest a minimum of 410 MB
e For the Host a minimum of 45 MB

Video: any supported by X.org Server

NOTE: To be able to install the Host or Guest, make sure that the user logged
on the computer has system user privileges.

To download the Connect for the supported Linux distributions refer to the
following link.
e The download page includes separate installation or archive files for the
Guest and Host depending on your Linux distribution.
e The archive file contains the following files:
o ca-certificates.crt
o eula.txt
o install.pl
0 installpubkey
o Impero.pub
o Impero-*.deb | Impero-*.rpm (based on the Linux distribution in

use)

install.pl is a Perl script file that handles the installation process via the

terminal.


https://imperosolutions.sharepoint.com/sites/TheImperoAcademy/Shared%20Documents/Netop%20Backup/Quick%20Install%20Guide/Linux/x.org
https://imperosolutions.sharepoint.com/sites/TheImperoAcademy/Shared%20Documents/Netop%20Backup/Quick%20Install%20Guide/Linux/x.org
https://www.imperosoftware.com/impero-connect/downloads/
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To list all the parameters of the install.pl Perl script, use the following

command:

install.pl --help

install.pl parameters table:

Function Command |

[--help] Prints the help message and exits.

[--version] Prints the version info and exits.

[--serial Installs the Guest | Host with the <serial> number

<serial>] license key.

[--debug] Turns debugging on.

[--license] Prints the License.

[--autoinstall] | Non-interactive installation assumes that you agree
with the License.

Example:
For the non-interactive Host installations, use the following command:

perl install.pl --autoinstall --host <serial>
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You can install the Guest and Host in two ways:
A. You double-click on the Impero-host *.deb | rpm, and Impero-
guest *.deb | rpminstallation file within your desktop environment.

B. Install them from the terminal.

NOTE: We recommend that you install the Guest and Host via the terminal.

Download the Guest

You can download the Guest from:
e the Portal

e the Impero website, by clicking on the following link

To download the Guest (Support Console) application from the Portal,
proceed as follows:

1. Log in the Portal.

2. Go to the My Devices page.

1 my DEVICES 2 Contact Neto

All Devices <[> Download Guest (Support Console) v |

Add device v |

Devices: Online %



https://www.imperosoftware.com/impero-connect/downloads/
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3. Click on the Download Guest (Support Console) button.

ToP
5] Remote Control

Dashboard

My sessions
My devices.
My mobile devices

Users

Devicas

Groups
Appiications
Roles

Role assignments

Dowmloads

Account security

Authentication

Logs

#f Configuration

1 MY DEVICES

All Devices

[ = o |

searchin: € Al fields

4 Hostname

7 ® [J DESKTOP-6QQAFHV

Hostname

Alias

£ contact Netop

Operating system Logged in

Status

® Online for about 187 days

= Purchase

user

Users: 48 / 1000

Alias,

DESKTOP-6Q0AFHV

4. Select the desired platform from the dropdown menu.

ETOP
& Remote Control

Dashboard

My sessions
My devices
My mobile devices

Users
Devices
Groups
Appiications
Roles.

Role assignm
Downloads

Account security

Authentication

Logs

Configuration

1 mY DEVICES

All Devices

[ = oo

5. Save the archive.

ers

searchin: € Al ields

4 Hostname

Tr @ LJ DESKTOP-6QQAFHV

Hostname

Allas

£ Contact Netop

Operating system Logged in

Status

™ Online for about 187 days

‘= Purchase

user

Users: 48/ 1000

Alias

DESKTOP-6Q0AFHV

OnDemand users: 5/5 Devices: 24 /300 v
| > Download Guest (Support Console) v | Add device v
Group T Logged in user
OnDemand users: 5/5 Devices: 24 /300 v

Download Guest (Support Console) a

B Windows

& macos

A RedHat Enterprise 7.x/ CentOS 7.x
A Ubuntu 16.04 /18.04

) SUSE Enterprise 12.x

Add device

1iin user
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Install the Guest

A. Install the Guest through the Software Install’

To install the Guest through the application software, proceed as follows:
1. Go to the file path of the extracted Guest.
2. Double click on the Impero-guest *.deb |rpm installation file. The

following window is displayed.

Never

3. To install the Guest, click on the Install button.

4. Specify your password for authentication.
B. Install the Guest via the terminal”

To install the Guest via the terminal, proceed as follows:
1. Go to the file path of the extracted Guest.
2. Open up a terminal window.

3. Use the following Perl script to initiate the installation process:
sudo perl install.pl

-~

john@john-VirtualBox: ~/Downloads/wetransfer-ab5ac7/netop-guest-12.81-ubuntu-32bit

File Edit View Search Terminal Help

john@john-VirtualBox:~/Downloads/wetransfer-ab5ac7/net
tS sudo perl install.pl

Specify the password for authentication.

* The procedure applies to Ubuntu version 18.04.1 distribution of Linux.
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As part of the installation process, it is necessary that you accept the End

User License Agreement.

Jjohn@john-VirtualBox: ~/Downloads/wetransfer-abSac7/netop-guest-12.81-ubuntu-32bit™

File Edit View Search Terminal Help
use anonymous technical data and related information, including but not limit
to technical infermation about Your devic
system and application software, and peripherals, that is gathered periodical
to facilitate the provision of software updates, product support and other se
rvices to You (if any) related to the Licens
ed Software. Netop Business Solutions may use this information, as long as it is
in a form that does not personally identify You, to improve its products or to
provide services or technologies to You.

10. Contact Information. Should you have any questions, complaints or claims wit
h respect to the Agreement, please contact us at Netop Business Solutions A
regnerodvej 127, DK-3460 Birkerod, Denmark o

r +45 4590 25 25 or info@netop.com.

11. Vendor signing. For the Android version of Netop Mobile and Embedded it is e
xplicitly prohibited for end-users or any other to vendor sign or cause vendor s
igning of this module and thereby enabling t

his module to reach necessary system resources needed for the viewing of the scr
een and injection of input to the devices, that it otherwise could not reach. Do
ing so immediately revokes the license to us

e this module.

Do you accept this license ? [yes/No/quit] ;yesl

Specify the type of license you want to use for the Guest. The following
options are available:

e Portal - all communication happens using the Portal (a Portal account is
required)

e Trial — a 15-day fully-featured trial

e Custom - specify the required license after buying the product

Activities =] Terminal Lu 10:30 E20 0~
$s root@john-VirtualBox: ~/Downloads/wetransfer-ab5ac7/netop-guest-12.81-ubuntu-32bit™ = @
File Edit View Search Terminal Help

9. Consent to Use of Data. You agree that Netop Business Solutions may collect
and use anonymous technical data and related information, including but not lim
ited to technical information about Your device, system and application softwar
e, and peripherals, that is gathered periodically to facilitate the provision o
f software updates, product support and other services to You (if any) related
to the Licensed Software. Netop Business Solutions may use this information, as
loeng as it is in a form that does not personally identify You, to improve its
products or to provide services or technologies to You.

10. contact Information. Should you have any questions, complaints or claims wi
th respect to the Agreement, please contact us at Netop Business Solutions A/S,
Bregnerodvej 127, DK-3460 Birkerod, Denmark or +45 4590 25 25 or info@netop.co
m.

11. Vendor signing. For the Android version of Netop Mobile and Embedded it is
explicitly prohibited for end-users or any other to vendor sign or cause vendor
signing of this module and thereby enabling this module to reach necessary sys
tem resources needed for the viewing of the screen and injection of input to th
e devices, that it otherwise could not reach. Doing so immediately revokes the
license to use this module.

=
=
=
ES

)

Do you accept this license ? [yes/No/fquit] =YES

o]

[3] Which type of license do you want to use for Netop Guest? [T]rial / [p]orta
1 / [c]ustom:
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Guest installed successfully.

Activities =] Terminal ~ Lu 10:31 L O IRe

root@john-VirtualBox: ~/Downloads/wetransfer-ab5ac7/netop-guest-12.81-ubuntu-32bit! s

File Edit View Search Terminal Help

11. Vendor signing. For the Android version of Netop Mobile and Embedded it is
explicitly prohibited for end-users or any other to vendor sign or cause vendor
signing of this module and thereby enabling this module to reach necessary sys
tem resources needed for the viewing of the screen and injection of input to th
e devices, that it otherwise could not reach. Doing so immediately revokes the
license to use this module.

Do you accept this license ? [yes/No/fquit] >YES

[3] Which type of license do you want to use for Netop Guest? [T]rial / [pJorta
1 / [c]ustom:

p
Please reply: [T]rial / [plortal / [c]ustom

[3] Wwhich type of license do you want to use for Netop Guest? [T]rial / [pJorta
1 / [c]ustom:

The license has been successfully set
Serial Number validated OK.
Netop Guest application has been installed and activated.
You can start the Netop Guest application by typing 'netopguest' as a regular u

ser.
Thank you for using Netop Solutions!

5 PERR: XN |E A

TE:
e You are prompted to specify a license key.

e If you do not specify a license key, Guest automatically installs itself in
trial mode.

Download the Host

You can download the Guest from:

e the Portal

e the Impero website, by clicking on the following link

10


https://www.imperosoftware.com/impero-connect/downloads/
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To download the Host application from the Portal, proceed as follows:

1. Log in the Portal.

2. Go to the My Devices page.

SRR | MY DEVICES

Dashboard All Devices

My sessions
My devices.

My mobike devices

[ = v
Users

Devices

Groups

Appiications
Roles
Role assignments

Downloads

Account security
Authentication
Logs

Configuration

Online X | Clear all the filt

2 Contact Netop ‘= Purchase Users: 48 /1000 OnDemand users: 5/5 Devices: 24 /300

<> Download Guest (Support Console) v Add device v
Searchin: € All ields Hostname Alias Operating system Logged in user
status Alias Group A Logged in user
7 @ [J DESKTOP-6QQAFHV W Oniine for about 167 days DESKTOP-60QAFHV Teii grei crist

3. Click on the Add device button.

PN Bl L MY DEVICES

Dashboard All Devices

My sessions
My devices.

My mobile devices

=5
Users

Devices

Groups
Appiications
Roles

Role assignments

Downloads

Account security

Authentication

Logs

Configuration

Clear all the filters

£ contact Netop ‘= Purchase Users: 48 /1000 OnDemand use Devices: 24 /300

<> Download Guest (Support Gonsole) ¥ Add device v
searchin: € Al ields Hostname Alias Operating system Logged in user
status Alias Group ¥ Logged in user
¥ ® (J DESKTOP-6QQAFHV ® Oniine for about 167 days DESKTOP-60QAFHV Teii grei crist

11
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4. Select the Host for another operating system option from the dropdown

menu.

0 ==
Remote Control

@ Dashboard

2 .
g My sessions

L] My devices.

O My mobie devices

L

[ Devices

85 Groups

(9 Applications

ount security

@, Authenticaion

[ my DEVICES & Contact Netop = Purchase 4871000 e 515 e 247300 -

All Devices <[> Download Guest (Support Console) v | Add des

nin. @) Alfekds () Hos

Al Opesating system Logge

# Hostname Y Status. Aras Group ¥ Logged in user

BT ¢ - o e .

5. Select the Host for the desired platform.

8 =
Remote Control

)

)

a

an

=

Dashboard

My sessions
My devices.

My mobile devices

Users

Devices

82 Groups

a

L]
a
B

L

Applications
Roles
Role assignments

Dowmloads

Account security

Authentication

Logs

[

Netop

«

I DOWNLOADS © Contact Netop = Purchase Users: 4871000 OnDemand users: 5/5 Devices: 24./300 v

agent enroll

Download installers

# Edit | | © Upload

| Q@ Revoke |

5@ Windows v
@ macOs v
A Linux A

Download offline installer for
RedHat Enterprise 7.x / CentOS 7.x
Ubuntu 16.04 / 18.04

SUSE Enterprise 12.x

Send installer to another user

7 Send link

@ Copy link

Package details

Name agent enrol

status

Description =

Valid from 2020-10-06

6. Save the archive.

12
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Install the Host”
A.Install the Host via the Software Installer”
To install the Host via the Software Installer, proceed as follows:

1. Go to the file path of the extracted Host.

2. Double click on the Impero-host *.deb | rpm installation file. The

following window is displayed.

impero-host
'
v Impero Host

Install

's actual desktop for
tc. Imperoiis

. NOT permitted.

ation (From /etc/NetopHost/cfg/).

Details

1 12.90-0ubuntu1
dated  Never

cense Proprietary
impero-host_12.90-0ubuntu1_amds4.deb
Download Sigdbytes

3. To install the Host, click on the Install button.

4. Specify the password for authentication.

B. Install the Host via the terminal’

To install the Host via the terminal, proceed as follows:
1. Go to the file path of the extracted Host.
2. Open up a terminal window.

3. Use the following Perl script to initiate the installation process:

sudo perl install.pl

* The procedure applies to Ubuntu version 18.04.1 distribution of Linux.

* The procedure applies to Ubuntu version 18.04.1 distribution of Linux.
13
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4. As part of the installation process, it is necessary that you accept the

Acceptable Use Policy.

Activities [ Terminal v Vi11:49
andrei@home: ~/Desktop/impero-host-12.90-ubuntu-64bit

File Edit view Search Terminal Help
IMPERO ACCEPTABLE USE POLICY

PLEASE READ THE TERMS OF THIS POLICY CAREFULLY BEFORE USING THE SOFTWARE. This
AUP governs your use, access and distribution of the products provided to you b
y Impero (the “Software”), as well as any other services or activities provided
to you (together, the “Services”). By using our Services, you confirm that you
accept the terms of this policy and that you agree to comply with them. If you
do not agree to these terms, you must not use our Services.

Who we are and how to contact us

The site www.imperosoftware.com and its related Services are operated on behalf
of the Impero Group. The Impero Group forms part of any and all subsidiary com
panies of Impala Bidco Limited, a company incorporated in England and Wales wit
h registration number 10878303, registered at Oak House, Mere Way Ruddington Fi
elds Business Park, Ruddington, Nottingham, England, NG11 6JS, consisting of Im
pero Companies and Netop Companies, as identified in the Organisation Structure
, available at https://www.imperosoftware.com/uk/policies-terms/.

To contact us in relation to this AUP, please emall legal@imperosoftware.com

Prohibited uses

+9
%
=
=
=]

You may use our Services only for lawful purposes. You may not use our Service

5. Specify the type of license you want to use for the Host. The following
options are available:
a. Portal — all communication happens using the Portal (a Portal account
is required)

i. Specify if you have a Portal account.

Activities =] Terminal ~ Vi 11:51
s andrei@home: ~/Desktop/impero-host-12.90-ubuntu-64bit

File Edit View Search Terminal Help

governing law of the contract shall be the substantive law of Dubai, United Ar
ab Emirates. In any arbitration commenced pursuant to this clause, the number o
f arbitrators shall be one; and the seat, or legal place, of arbitration shall
be the Dubai International Financial Centre (Dubai, United Arab Emirates).

UK, EU, Rest of World. If you are based anywhere else in the world and contract
ing with any other of the Impero or Netop Companies, then the AUP is governed b
y the law of England and Wales and each of us expressly and unconditionally sub
mits to the exclusive jurisdiction of the courts of England and Wales

We may make changes to the terms of this policy

We may update this AUP over time as we deem necessary and appropriate in respon
se to legal or regulatory changes, technology advances, or as we identify new f
orms of behaviour which pose a risk to our users, shared systems, or is inconsi
stent with our or our customer’s legal obligations.

Last updated: 8th September 2021.

Do you accept this license? [yes/No] >y

[3
1

&
)
=
S
P

Which type of license do you want to use for Impero Host? [T]rial / [plorta
[c]ustom: p
Validating license ...
License key validated OK.
Your license has been saved.
Do you have a Impero Portal account? [yes/No/quit] >I

1
!

14
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ii. Specify the enrollment key for your Portal account.

Activities [ Terminal ~ Lu 10:28 s O -

$s root@john-VirtualBox: ~/Downloads/wetransfer-ab5ac7/netop-host-12.81-ubuntu-64bit: (<]
File Edit View Search Terminal Help

to the Licensed Software. Netop Business Solutions may use this information, as
long as it is in a form that does not personally identify You, to improve its
products or to provide services or technologies to You.

10. Contact Information. Should you have any questions, complaints or claims wi
th respect to the Agreement, please contact us at Netop Business Solutions A/S,
Bregnerodvej 127, DK-3460 Birkerod, Denmark or +45 4590 25 25 or info@netop.co
m.

11. Vendor signing. For the Android version of Netop Mobile and Embedded it is
explicitly prohibited for end-users or any other to vendor sign or cause vendor
signing of this module and thereby enabling this module to reach necessary sys
tem resources needed for the viewing of the screen and injection of input to th
e devices, that it otherwise could not reach. Doing so immediately revokes the
license to use this module.

Do you accept this license? [yes/No/quit] =>yes

[3] Which type of license do you want to use for Netop Host? [T]rial / [pJortal
J/ [c]ustom:
p
Validating license ...
License key validated 0K.
Your license has been saved.
Do you have a Netop Portal account? [yes/No/fquit] >y

<
=
=
A
a

ees Enrollment key : [l

b. Trial — a 15-day fully-featured trial.
i. Specify if you have a Portal account.
ii. Specify the enroliment key for the Portal account.

c. Custom - specify the required license after buying the product.
i. Enter the License key for the Host.

NOTE:
You are prompted to specify a license key.

If you do not specify a license key, Host automatically installs itself
in Trial mode.

i. Specify if you have a Portal account.
. Specify the enrollment key.

15
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Guest

Load and Unload the Guest

To load the Guest, execute the following command in a terminal window:

Imperoguest

Netop Guest 0

File Connection Edit View Tools Help
P E A% @Rt

(5 Phonebook Quick Connect | -#: Connections ] o) History

Host Communication Profile

TCP/IP Address:

[Nemp Portal E]
[ v
Name (Optional, use with gateway):
+| Live Update
( v
Connect l) Browse || & Disconnect l LQ Connection Properties... ]
Hosts list
Host ID User Name Host UUID IP

\_Metop Network /\_Windows Network [

o
To unload the Guest, click on Exit from the File menu.

Impero Guest functionality
To connect to another port number than the Impero default port 6052, add

the port number to the Host name or address after a colon, for example,
192.168.100.1:1234.

16
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Host

Host includes the following programs:

e Impero Host Daemon (Imperohostd) - The Impero Host Daemon runs
when the computer operating system starts. A user with system user
privileges can start and stop the Impero Host Daemon.

e Impero Host Program (Imperohost) — The Impero Host Program loads and
starts when the Impero Host Daemon loads. If started, the communication
is initialized enabling a Impero Guest to connect. A user can typically
control the Impero Host Program from the Impero Host GULI.

e Impero Host GUI (Imperohostgui) — The Impero Host GUI displays the
Impero Host graphical user interface. It does not automatically load when
the Impero Host Program loads. A user can load and unload the Impero
Host GUI.

NOTE: Only a user with system privileges can make changes to the Impero
Host program options.

Start and stop the Impero Host Daemon

The Impero Host Daemon starts and stops with the Linux operating system. A
user with system user privileges can start, stop and report the status of the

Impero Host Daemon with the following terminal window commands:

Command Function Description |
/etc/init.d/Imperohostd | Start You use this command to start the
start Impero Host Daemon and load the

Impero Host Program.
/etc/init.d/Imperohostd | Restart |You use this command to restart
restart the Impero Host Daemon and load
the Impero Host Program.

17
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/etc/init.d/Imperohostd | Status You use this command to return a
status message of whether the Impero
Host Daemon is running or not.
/etc/init.d/Imperohostd | Stop You use this command to unload
stop the Impero Host Program and
stop the Impero Host Daemon.

Display and hide the Impero Host window

The Impero Host GUI doesn’t automatically load when the Impero Host
Program loads. If the Impero Host Program is loaded, execute the following

command in a terminal window:

Imperohostgui

The Impero Host interface is displayed.

Netop Host o

File View Action Session Tools Help
> B oD K

General | History Services  Communication | Names

Status
Running
Host ID

john-VirtualBox

Host UUID

Address

192.168.201.6

o

NOTE: The Imperohostgui command assumes that the Impero Host GUI
program file is located in the [fusr/bin directory or is located in a directory
included in the global PATH. If the Impero Host GUI is located in another
directory then specify the full directory path before the Imperohostgui
command.

18
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To unload the Impero Host GUI, click on Exit from the File menu.

Host Functionality

The Host window contains most of the Host for Windows window elements
but has reduced functionality in comparison with the Windows version and the

set up is organized differently.

The Host enables a remote Guest to connect by using the TCP/IP, TCP/IP
(TCP), Serial (modem), HTTP, WebConnect, WebConnect3, and the Impero
Portal communication protocols. Once authenticated, the Guest can view the
remote screen, control the keyboard and mouse, transfer files between the

computers, and interact with the end-user.

To change the setup options of the Host, click on Options on the toolbar or
from the Tools menu. The Impero Host Configuration login window is

displayed.

 Netop Host Configuration - Login

Select account for changing configuration

Username root
Password I

Specify a valid Linux username and the matching password.

NOTE: To change the setup options, make sure that you have the privileges to
edit the /var/opt/Impero/host/host.xml file.

19
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Click on OK. The Impero Host Manager is displayed.

NetopHost Attribute “ Value
= NetopHost
~ &% Cconfiguration
~ "4, Local configuration
» £Z Addresslists
- \;l Host computer
% Communication
¥ General
REC
o MNames

»

b

b

b @ Security

v Help requests

+ Debug Log

+ Event Log

¢+ Tunnel Configuration
¢+ Host Monitor

v * Guest users

~ ™ security
MNetop Portal access rights
b @ Roles
v B/ security server authentication
v & system authentication
/% Netop authentication

Uninstall

Uninstall the Guest

To uninstall the Guest, either use the operating system’s package or as root
execute the following commands in a terminal window:
e For RedHat, CentOS, SUSE:

rpm -e Impero-guest

e For Ubuntu:

sudo apt autoremove Impero-guest

20



IMPERO CONNECT FOR LINUXINSTALLATION GUIDE

Uninstall the Host

To uninstall the Host, either use the operating system’s package manager or
as root execute the following commands in a terminal window:
e For RedHat, CentOS, SUSE:

rpm - e Impero-host

e For Ubuntu:

sudo apt autoremove Impero-host

Refer to the specific package manager of your distribution that you are using

for more information on how to remove the installed packages.

21



